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Hello	everyone.I	made	this	tutorial	not	too	long	ago	on	how	to	use	Action	Replay	codes	with	the	Dolphin	emulator.	It	took	me	forever	to	figure	out.	I	was	finally	able	to	do	so	with	the	help	of	a	topic	created	by	Arch	Feline.The	comments	I've	gotten	on	Youtube	for	this	video	have	been	positive,	so	I	hope	it	helps	some	of	you.	This	being	said,	if	you	run
into	any	problems,	make	sure	you	check	the	comments	before	asking	here	Video:	tutorial:GCNcrypt:	Tools	needed:-The	Dolphin	emulator	(of	course!)-GCNcrypt	(check	the	5th	step	of	this	guide	for	more	information)	1.)	Open	"Dolphin.exe"	(I'll	be	using	version	3.0	as	an	example.)	2.)	If	you	don't	have	any	ISO's	listed	in	the	main	menu,	go	to	"Browse"
and	navigate	to	the	folder	containing	the	.ISO	you	wish	to	use	Action	Replay	codes	on.	3.)	Go	to	"Options",	and	then	"Configure".	Under	the	"General"	tab,	make	sure	"Enable	Cheats"	is	selected.	This	is	basically	the	master	"kill	switch",	so	if	you	ever	want	to	disable	your	Action	Replay	codes,	go	here	and	disable	them.	4.)	Right-click	on	the	game	in
your	list	you	wish	to	use	Action	Replay	codes	on,	then	go	to	"Properties".	Once	in	the	Properties	menu,	go	to	the	"AR	Codes"	tab.Note:	Gecko	Codes	(	)	can	also	be	downloaded	automatically	from	the	Gecko	Codes	database	(check	the	"Gecko	Codes"	tab),	but	there	aren't	Gecko	codes	for	every	game	out	there,	and	my	tutorial	doesn't	cover	these.	5.)
Once	in	the	"AR	Codes"	tab,	click	the	"Add..."	button.	Here,	you	will	be	able	to	input	a	name	for	your	Action	Replay	code	(it	can	be	anything,	as	long	as	you	can	understand	what	it	is),	as	well	as	the	code	itself.	It	says	that	you	may	insert	encrypted	codes,	but	I've	been	inputting	the	decrypted	codes	instead,	and	have	thus	far	had	no	issues.	To	decrypt
Action	Replay	codes,	you'll	need	"GCNcrypt".	This	is	a	free,	open-source	utility	designed	to	encrypt	and	decrypt	Nintendo	Gamecube	Action	Replay	codes.	If	you	can't	find	it	via	Google	(and,	you	should	be	able	to	quite	easily),	just	contact	me	and	I'll	give	it	to	you	myself.	Note:	You	must	enter	codes	one	line	at	a	time!	Meaning,	if	your	code	has	multiple
lines	of	code,	you	must	enter	one	line	at	a	time.	Check	the	video	for	a	better	explanation.	6.)	Hit	"OK"	once	you're	done	entering	your	code,	and	now	you	may	hightlight	it	to	remove	or	edit	it.	If	there	are	more	parts	of	your	code	that	need	to	be	entered,	simply	go	to	"Add..."	and	do	it	all	over	again.	When	finished,	click	"Close"	and	double-click	your
game	from	the	list.	As	your	game	loads,	you	should	notice	your	codes	being	enabled	via	the	on-screen	text.	While	in	game,	you	can	go	to	"Tools"	>	"Cheats	Manager"	to	further	toy	around,	but	you're	basically	good	to	go!	Credits:--------Original	explanation	on	the	Dolphin	hacking/cheating	function:	Arch	Feline	of	the	Dolphin	Emulator	forum	Video/This
tutorial:	LeonflowenVideo	music:	Phantasy	Star	Online:	Episode	III	-	Tower	of	"Caelum"	*Not	added	because	YouTube	enjoys	causing	hell	for	it's	uploaders	@_@(Sorry	for	the	poor	video	quality!)	Attached	Files	AR	Codes	with	Dolphin	Tutorial.txt	(Size:	2.63	KB	/	Downloads:	3,703)	06-22-2012,	04:55	PM	(This	post	was	last	modified:	06-22-2012,	04:56
PM	by	Roger	Carvalho.)#2	My	congratulations	on	the	excellent	topic!It	was	exactly	what	you	were	looking	for,	thank	you	very	muchSorry	my	bad	English,	I'm	from	Brazil	Thanks	a	million	for	the	tutorial.	I	was	wondering	how	to	do	it	with	Dolphin	Emu.	for	some	reason	cheats	arent	working	properly.say	for	example	im	on	luigis	mansion	and	i	activate
the	the	'all	doors	are	unlocked'	cheat	code	the	game	will	boot	up	but	the	title	screen	will	look	corrupted	and	when	i	try	and	play	the	game	it	just	keeps	giving	me	error	messages	saying	'unable	to	resolve	write	address	b7bbee07	PC'.	this	only	happens	when	i	activate	a	cheeat	i	added,	if	i	use	a	cheat	that	was	already	there	the	game	works	fine.	08-28-
2018,	03:48	AM	(This	post	was	last	modified:	08-28-2018,	03:49	AM	by	ExtremeDude2.)#5	Does	it	let	you	keep	playing	after	the	error?	You	can	try	disabling	"Panic	Handlers"	in	Settings	>	Interface.Edit:	Just	looked	at	the	OP	date	and	it's	really	old,	you	should	make	a	new	thread	instead	of	using	this	one.	Check	out	my	videos(dead)	08-28-2018,	04:03
AM	(This	post	was	last	modified:	08-28-2018,	04:03	AM	by	zmech9001.)#6	(08-28-2018,	03:48	AM)ExtremeDude2	Wrote:	Does	it	let	you	keep	playing	after	the	error?	You	can	try	disabling	"Panic	Handlers"	in	Settings	>	Interface.Edit:	Just	looked	at	the	OP	date	and	it's	really	old,	you	should	make	a	new	thread	instead	of	using	this	one.no.	when	i	click
OK	it	shows	the	same	message	again.	every	single	time	i	close	the	message	another	one	appears.	the	game	crashes	and	will	only	close	if	i	press	OKenough	times	but	when	it	closes	dolphin	will	close	too.	Do	not	bump	very	old	threads.	make	a	new	one.	Our	members	have	made	a	total	of	508,575	posts	in	57,164	threads.	We	currently	have	15,963
members	registered.	Please	welcome	our	newest	member,	SL1iick	The	most	users	online	at	one	time	was	19,005	on	06-23-2025	at	09:14	AM	06-11-2020,	05:34	AM	(This	post	was	last	modified:	06-12-2020,	01:36	AM	by	hoobertuder.)#1	EDIT:	Hi,	i	am	on	windows	10	(brand	new	pc)	and	dolphin	simply	does	not	launch.	I	tried	the	latest	beta,	and	the
latest	stable	one.	Same	result,	there	is	no	error,	it	simply	does	not	launch.	things	I	tried	already:	-	Running	as	Admin-	Installing	the	correct	redist	runtimes	listed	on	the	dolphin	download	page-	Installign	every	other	available	redist-	Trying	an	old,	32	bit	version	of	dolphin-	Updating	windows	10-	Updating	all	drivers,	every	last	one.-	Virus	scan	and
windows	10	reinstall	I	also	tried	an	ANCIENT	version	(6	years	old),	and	this	one	opened,	but	crashes	when	I	open	the	controller	configuration.	I	am	on	windows	10	64bit,	When	i	try	to	run	the	latest	dolphin	or	a	recent	one,	it	does	not	launch.	I	get	the	hourglass	symbol	for	a	split	second	then	it	goes	away.	The	process	is	not	hanging	anywhere,	it's	just
insta	crashing	with	no	error.	it	is	not	generating	any	logs	or	dump	files	either,	the	old	one	did	but	not	the	new	one.	Did	you	instal	the	VS	runtime	2019	from	the	link	on	the	downloads	page?	Yes,	sorry	I	forgot	to	mentioned	I	had	installed	that,	both	variants	of	it	as	long	as	every	other	redist	runtime	I	could	find.	I	tried	disconnecting	my	controller	(a
bluetooth	dongle	plus	an	xbox	one	controller)	but	it	had	no	change	in	either	the	latest	dolphin	not	running.	or	4.0.2	crashing	when	opening	settings/gcpad.	It	really	sucks	that	I	cannot	get	proper	logs	from	this,	however	if	I	launch	it	in	compatibility	mode	I	actually	do	get	a	crashing	error	instead	of	just	it	failing	to	open.On	windows	7	and	8.1	on	the
same	hardware	this	is	not	an	issue	however	downgrading	to	those	operating	systmes	is	simply	not	an	option	Grab	a	fresh	copy	of	the	latest	Dolphin	dev	build,	extract	it	all	to	a	fresh	new	folder,	and	create	a	blank	txt	file	named	"portable.txt"	in	the	same	folder	as	Dolphin.exe.	This	will	skip	the	Global	Dolphin	config	and	create	a	new	fresh	config	locally
inside	that	folder.	If	this	starts,	don't	change	any	settings,	just	load	a	game	up	and	see	if	it	crashes	or	not.	If	this	works,	it	means	you	have	something	corrupted	in	the	Dolphin	Global	Directory	located	in	"My	Documents".If	it	doesn't	work,	it	means	you've	got	some	other	issue.	hey	sorry	my	area	has	had	no	power	for	a	few	weeks	now.	I	think	it	might
be	related	to	controller	config,	because	the	6	year	old	version	ran	(didn't	test	games)	but	when	opening	controller	config	it	crashed.	And	no	errors	of	any	kind	were	generatedMy	last,	desperate	guess	is	that	this	is	probably	because	the	company	I	got	the	prebuilt	from	has	prepackaged	a	weird	oem	version	of	w10	I	tried	this.	making	it	portable	does
not	change	anything,	I	tried	the	latest	dev	build	and	the	stable	one	too.	And	just	to	be	clear,	you're	extracting	the	entire	contents	of	the	zip	folder,	and	not	just	Dolphin.exe,	correct?	Also,	what	are	your	PC	specs?	Just	CPU/GPU	should	be	fine.Long	shot:	have	you	run	the	DirectX	Web	Installer?	shot	2:	does	Dolphin	run	if	you	start	your	computer	in	Safe
Mode?	I	Just	Tried	these	and	neither	of	them	work.	I	had	Just	uninstalled	VJoy	and	FreePie	So	I	would	like	to	know	if	that	has	anything	to	do	with	it.	Hi	I	just	uninstalled	literally	everything	attached	to	vjoy	and	now	it	works	so	I	guess	I	just	wasn't	thorough	enough.	Well,	open	Dolphin,	go	to	Tools	=>	Perform	Online	System	Update	=>	<	the	region
that	matches	most	of	your	ISOs	>.	Once	the	update	is	finished,	go	to	Tools	=>	Load	Wii	System	Menu	and	you	should	see	the	Mii	Channel	on	the	channel	grid,	go	there	to	create	new	Miis...	Avell	A70	MOB:	Core	i7-11800H,	GeForce	RTX	3060,	32	GB	DDR4-3200,	Windows	11	(Insider	Preview)ASRock	Z97M	OC	Formula:	Pentium	G3258,	GeForce	GT
440,	16	GB	DDR3-1600,Windows	10	(22H2)	Dolphin	does	not	Pre-Compile	Shaders	for	games	when	launching	them,	Despite	the	Compile	Shaders	before	Starting	option	being	onAll	of	my	games	lag	and	freeze	like	crazy	because	of	it	Using	VulkanUsing	RTX	4060	GPUEven	if	i	clear	the	Cache	for	Dolphin	and	on	my	GPU,	then	launching	a	game	via	a
created	Desktop	Shortcut	it	does	not	do	the	step	Same	issue	for	me	with	vulkan,	even	with	a	fresh	dolphin	install.	And	the	games	with	which	it	refuses	to	compile	shaders	are	very	stuttery.	Where	are	the	save	files	when	I	save	in	game?	For	instance,	I'm	playing	Skyward	Sword	right	now,	and	using	version	7719.	When	I	save	the	"Regular	way",	where
are	these	located?	Is	it	possible	to	specify	where	I'd	like	these	saved?	(11-21-2011,	03:31	AM)kturcotte	Wrote:	Where	are	the	save	files	when	I	save	in	game?	For	instance,	I'm	playing	Skyward	Sword	right	now,	and	using	version	7719.	When	I	save	the	"Regular	way",	where	are	these	located?	Is	it	possible	to	specify	where	I'd	like	these	saved?The
easiest	way	I	have	found	is	when	you	have	Dolphen	launched	no	game	running,	is	to	right	click	on	your	desired	game	title	and	then	click	on	"Open	Wii	Save	folder"	and	this	takes	you	right	to	the	save	files	for	that	particular	game.	If	you	thought	the	Backpack	Peach	plush	is	the	biggest	official	plush,	then	your	mistaken'	my	friend.	11-21-2011,	03:36
AM	(This	post	was	last	modified:	11-21-2011,	03:37	AM	by	LordVador.)#3	MCs	are	here	:	Dolphin	Folder/User/GC	(or	Wii)And	if	you	use	SaveStates	here	:	Dolphin	Folder/User/StateSaves	[color=#ff0000][color=#006600]i5	3570K	@	4.5GHz/GTX	660	Ti/RAM	4GB/Win7	x64[/color][/color]	Is	it	possible	to	change	the	save	dir?	Got	2	drives	and	I	want	it
to	save	in	the	secondary	drive	Lenovo	IdeaPad	320S	|	Windows	10	x64	|	i5	8250U	|	8GB	Ram	You	can	change	the	global	user	directory	with	the	instructions	here	->	Intel	Xeon	w7-3465X	OC	|	Asus	Pro	WS	W790-E	Sage	SE	|	NVIDIA	GeForce	RTX	4090	FE	|	8x16GiB	G-Skill	Zeta	R5	DDR5-6000	|	Windows	11	24H2	|	(details)MacBook	Pro	14in	|	M1	Max
(32	GPU	Cores)	|	64GB	LPDDR5	6400	|	macOS	13	Thanks,	it	saysMake	sure	that	you	include	"User"	in	it,	since	it	will	assume	whatever	path	it	is	directed	to	is	the	User	folder.	If	you	point	it	to	the	Desktop	for	example,	you	will	have	a	very	messy	situation.So	would	there	be	a	problem	if	I	set	the	root	of	my	2nd	drive	as	the	new	location?	I.e.	D:\Dolphin
Emulator	Lenovo	IdeaPad	320S	|	Windows	10	x64	|	i5	8250U	|	8GB	Ram	IntroductionI	recently	got	a	Guitar	Hero/Band	Hero	Drum	Kit	set	up	working	using	MayFlash	DolphinBar	and	Wiimote	(RVL-003).	With	this	success,	I	also	wanted	to	try	a	wired	connection.	The	Raphnet	Classic	Controller	to	USB	adapter	has	been	a	staple	recommendation	for
years	and	is	still	not	a	bad	choice	by	any	means,	though	it	lacks	the	tilt	sensor.	With	the	advent	of	3D	printers,	modern	adapters	have	emerged	from	independent	engineers,	including	tilt	support.After	some	research,	I	decided	to	go	with	the	RetroCultMods	V3	Wii	Adapter.	While	the	drum	kit	does	not	need	the	tilt	functionality,	it	makes	the	RCM	Wii
Adapter	more	versatile	if	you're	planning	to	use	it	for	the	guitar	instruments.	It	basically	turns	the	drum	kit	into	an	XInput	device,	so	it	works	directly	with	PC	games	(e.g.	Clone	Hero)	or	emulators	(e.g.	Dolphin,	RPCS3).	Their	official	website	has	guides	for	guitars,	but	none	for	the	drum	kit,	which	is	why	I'm	writing	one	here	for	Dolphin.V3	Adapter
Plug	the	adapter	into	the	Wiimote	compartment	of	the	drum	kit.	I	know,	awkward	position	for	the	USB-C.	Plug	the	other	end	of	the	cable	to	a	USB-A	port	on	your	PC.	Dock	in	my	case.Update	the	firmware	if	prompted	using	the	RCM	Programming	Tool.	Follow	the	instructions	from	the	link.If	successful,	you	should	see	below.	Configure	>	V3	Adapter	>
V3	Adapter	-	GH	Drums	>	Load	Preset	Make	sure	to	do	this	first	before	configuring	the	controllers	in	Dolphin.DolphinPick	any	free	slot	for	the	Emulated	Wii	Remote.Select	XInput/0/Drum	Kit.Clear	all	default	mappings.Select	Drum	Kit	from	the	Extension	dropdown.Click	the	Extension	tab.	Hit	the	drum	pads	to	map	them.(Optional)	Set	Hit	Strengthto
a	lower	value	(e.g.	35%),	so	the	pads	do	not	need	to	be	hit	too	hard.Enter	a	name	for	the	controller	Profile.Save	the	profile.Hope	this	helps.	Cheers!	I	downloaded	dolphin	5.0,	but	my	library	is	empty,	realizing	that	I	have	to	get	ISOs/WADs	to	play	it,	but	I	don't	know	how.	If	you	could	reply	some	steps	to	getting	a	game	on	Dolphin,	it	would	be
appreciated.	I	also	thought,	if	the	format	isn't	ISO/WAD,	how	do	I	convert	it?	Again,	let	me	know	with	a	reply.	Follow	this	guide	to	copy	games	onto	your	computer:	that	guide	will	give	you	games	in	ISO	or	WAD	format	(unless	you	use	USB	Loader	GX),	but	Dolphin	does	support	a	number	of	other	formats	too	(like	WBFS,	which	is	what	USB	Loader	GX
gives	you).	(10-20-2019,	11:49	PM)appleboy711	Wrote:	I	downloaded	dolphin	5.0,	but	my	library	is	empty,	realizing	that	I	have	to	get	ISOs/WADs	to	play	it,	but	I	don't	know	how.	If	you	could	reply	some	steps	to	getting	a	game	on	Dolphin,	it	would	be	appreciated.	I	also	thought,	if	the	format	isn't	ISO/WAD,	how	do	I	convert	it?	Again,	let	me	know	with
a	reply.Also,	don't	download	5.0	but	download,	extract	and	use	the	latest	development	version	from	here:	has	been	out	for	more	than	3	years	and	has	had	over	10.000	fixes	and	enhancements,	which	makes	it	actually	more	stable	than	the	"stable"	version.	Check	my	profile	for	up	to	date	specs.	Greetings,	all.	Recently	I	tried	to	install	the	latest	dev	build
of	Dolphin.	After	I	got	the	necessary	files	to	run	it	(the	.dlls)	this	message	popped	up.	"The	procedure	entry	point	ucrtbase.abort	could	not	be	located	in	the	dynamic	link	library	api-ms-win-crt-runtime-l1-1-0.dll."	I	haven't	the	foggiest	what	this	means,	so	if	anyone	could	help	me,	that	would	be	great.	Thanks.	EDIT:	Figured	out	the	problem.	Didn't	have
VS	2015	installed.	Installed	that	and	it	fixed	it.	I	don't	recommend	downloading	DLLs	individually	off	the	internet.	All	you	need	is	the	Visual	studio	2015	C++	runtimes,	whiich	is	a	6	mb	download	from	Microsoft.Downloading	them	one	by	one	from	top	google	results	often	contain	malware	or	are	the	wrong	versions,	which	can	create	inexplicable	bugs.
Your	OS	is	broken	if	you	installed	things	correctly	and	it	still	didn't	work.	No	you	(or	your	friend)	should	not	be	downloading	random	DLLs	from	the	Internet	and	putting	them	in	directories	manually.	Also,	you	don't	need	to	install	VS.	Only	the	VS	2015	redistributables	are	required.	Visual	Studio	is	an	IDE.	The	VS	redistributables	are	a	set	of	libraries
(DLLs	on	Windows)	that	are	used	by	applications	such	as	Dolphin.	I	don't	know	precisely,	but	you	are	not	going	to	make	it	work	by	searching	those	files	and	"installing"	them	manually.	If	the	installer	doesn't	work,	you	need	to	fix	your	OS,	as	said	previously.	Remove	any	DLLs	you	have	downloaded	and	placed	manually,	make	sure	you	have	done	all
updates,	and	then	try	again.	If	it	still	won't	work,	well,	I'm	out	of	ideas.ps:	you	are	talking	about	your	friend's	PC,	right?	Because	even	with	the	VS2015	redist,	recent	dev	builds	won't	run	on	your	old	PC	because	it	doesn't	support	64	bits.	With	old	builds,	I	think	you	don't	need	the	VS2015	redist.	03-22-2016,	09:52	PM	(This	post	was	last	modified:	03-
23-2025,	01:40	AM	by	Admentus.	Edit	Reason:	Update	v2.5.0)#1	Thanks	to	the	efforts	of	GhostlyDark	(who	primarily	maintains	the	texture	pack)	SM64	Reloaded	is	available	for	the	Dolphin	emulator.	So	what	is	SM64	Reloaded?	It	is	an	unified	ultra	high	definition	texture	pack	designed	for	Dolphin	(through	the	Virtual	Console),	GlideN64/RT64	(for
use	on	Nintendo	64	emulators	such	as	Project64)	and	the	unofficial	PC	Port.	Just	about	everything	should	be	covered	for	the	international	version,	including	some	mods	here	and	there.	The	aim	is	to	make	the	texture	pack	look	as	vanilla-like	as	possible.	Texture	Pack	status	-	Current	version	is:	V2.5.0.-	Porting	is	done	for	now	with	1.830	textures
ported-	Both	packs	are	optimized	through	optiPNG.-	Both	packs	are	packed	in	the	7-zip	format.	You	might	need	to	download	7-zip	to	unpack	them.	Newer	versions	of	WinRAR	should	work	too.-	Supported	Super	Mario	64	versions:	NTSC-U,	PAL,	60	FPS	v2	&	Multiplayer	V1.4.2	NTSC-J	still	works,	but	is	not	supported.	Known	Issues	-	Super	Mario	64
Multiplayer	V1.4.2	does	not	correctly	display	the	controller	button	icons	(when	reading	message	boards).	This	issue	is	not	present	in	the	official	NTSC-U	and	PAL	versions.-	The	intro	demo	and	Mario	Cam	are	broken	in	Super	Mario	64:	60	FPS	v2.-	Set	the	texture	cache	toSafe,enable	Prefetch	Custom	Textures	or	set	the	CPU	Clock	Override	at150%	or
higher	if	you	are	encountering	flashing	textures	running	Super	Mario	64:	60	FPS	v2.-	The	NTSC-J	version	is	missing	fonts.	Other	missing	textures	could	be	the	Course	logo,	Main	Menu,	Ending	and	Buttons	Icons.-	The	French	and	German	languages	for	the	PAL	version	display	the	Course	logo	in	English,	still	in	HD.	The	fonts	are	supported	through.
Progress	listOutside	Peach's	Castle	->	FinishedInside	Peach's	Castle	->	FinishedBob-Omb	Battlefield	->	FinishedWhomp's	Fortress	->	FinishedJolly	Roger	Bay	->	FinishedCool	Cool	Mountain	->	FinishedBig	Boo's	Haunt	->	FinishedHaze	Maze	Cavern->	FinishedLethal	Lava	Land	->	FinishedShifting	Sand	Land	->	FinishedDire,	Dire	Docks	->
FinishedSnowman's	Land	->	FinishedWet-Dry	World	->	FinishedTall,	Tall	Mountain	->	FinishedTiny-Huge	Island	->	FinishedTick	Tock	Clock	->	FinishedRainbow	Ride	->	FinishedBowser	in	the	Dark	World	->	FinishedBowser	in	the	Fire	Sea	->	FinishedBowser	in	the	Sky	->	FinishedThe	Princess's	Secret	Slide	->	FinishedThe	Secret	Aquarium	->
FinishedWing	Mario	Over	the	Rainbow	->	FinishedTower	of	the	Wing	Cap	->	FinishedVanish	Cap	Under	the	Moat	->	FinishedCavern	of	the	Metal	Cap	->FinishedStart	Menu	->	FinishedThe	Interface	and	HUD	->	FinishedFonts	(Credits	Included)	->	FinishedMario	Himself	->	FinishedSpecial	Effects	->	FinishedPAL	->FinishedMultiplayer	->
FinishedNext	Update	Screenshots	&	Gameplay	Video's	Old	Gameplay	Videos	(made	by	matheusstaffa)	(made	by	Gamemasterplc)	by	Gamemasterplc)	(playlist	made	by	Gamemasterplc)	More	Screenshots	//evilgames.eu/texture-packs/img/s...ded-02.jpg	//evilgames.eu/texture-packs/img/s...ded-04.jpg	//evilgames.eu/texture-packs/img/s...ded-06.jpg
//evilgames.eu/texture-packs/img/s...ded-08.jpg	//evilgames.eu/texture-packs/img/s...ded-10.jpg	//evilgames.eu/texture-packs/img/s...ded-12.jpg	//evilgames.eu/texture-packs/img/s...ded-14.jpg	//evilgames.eu/texture-packs/img/s...ded-16.jpg	//evilgames.eu/texture-packs/img/s...ded-18.jpg	//evilgames.eu/texture-packs/img/s...ded-20.jpg
//evilgames.eu/texture-packs/img/s...ded-22.jpg	//evilgames.eu/texture-packs/img/s...ded-24.jpg	//evilgames.eu/texture-packs/img/s...ded-26.jpg	//evilgames.eu/texture-packs/img/s...ded-28.jpg	//evilgames.eu/texture-packs/img/s...ded-30.jpg	//evilgames.eu/texture-packs/img/s...ded-32.jpg	//evilgames.eu/texture-packs/img/s...ded-34.jpg
//evilgames.eu/texture-packs/img/s...ded-36.jpg	Download	Links:	---	Main	Mirror	(Dolphin,	GlideN64,	RT64,	PC)	---	---	Backup	Mirror	(Dolphin)	---	---	Patcher64+	Tool	(for	modding	SM64)	---	Installation	InstructionsDownload	the	latest	DDS	BC7	or	PNG	pack.	It	is	recommended	to	use	the	DDS	pack	which	is	much	faster.Download	the	latest	official
development	or	Ishiiruka	build.	Dolphin	5.0	and	builds	prior	to	that	are	not	compatible.DDS	BC7	is	supported	since	Dolphin	5.0-4894	and	reduced	RAM	usage	for	DDS	packs	is	supported	since	Dolphin	5.0-3506.	Custom	texture	pack	folder	name	and	multiple	GameID's	is	supported	since	Dolphin	5.0-11744.Place	the	texture	pack	folder	folder	(works
for	every	official	game	region)	in	"C:\Users\UserName\Documents\Dolphin	Emulator\Load\Textures".Enable	"Load	Custom	Textures"	in	Dolphin	(Graphics	->	Advanced	->	Utility).Enable	"Prefetch	Custom	Textures"	in	Dolphin	to	load	all	textures	at	once	to	reduce	stuttering.	This	option	requires	a	fair	bit	amount	of	RAM,	8	GB	should	be	enough.With
the	latest	development	build	the	DDS	pack	requires	2	GB	additional	RAM	(4	GB	for	PNG	pack).Disable	"Crop"	if	having	issues	going	fullscreen	(Graphics	->	Advanced	->	Misc).Get	the	Patcher64+	Tool	(check	download	links)	and	patch	some	essentials	improvements	for	optimal	quality:	"Remove	Filter",	"Extended	Draw	Distance",	"16:9	Widescreen"
and	"60	FPS".Improvements	Through	Action	Replay	or	Gecko	codes	Almost	every	available	version	of	Super	Mario	64	for	the	virtual	console	(including	the	Multiplayer	Edition)	has	his	own	Action	Replay	Codes	and	Gecko	Codes.	Check	carefully	for	which	version	the	codes	are	and	if	they	are	AR	or	Gecko.Credits	to	darkludx	for	providing	the	"Hide
HUD	Display",	"Zoom	Out	Camera",	"Activate	Cap	Anywhere"	and	"Extended	Draw	Distance"	codesCredits	to	gamemasterplc	for	providing	the	"Widescreen	Aspect	Ratio	Fix	for	16:9",	"Completed	Save	Files",	"Remove	Dark	Filter",	"Damage	Taken",	"Widescreen	Aspect	Ratio	Fix",	"Walk	While	Reading	a	Sign",	"Optimized	HUD",	"Left-Aligned
Textboxes"	and	"Super	Hard	Mode"	codes.	Super	Mario	64	(NTSC-U)	/	Super	Mario	64:	60	FPS	v2	(NTSC-U):Widescreen	$	Widescreen	Aspect	Ratio	Fix	for	16:9	(Gecko	Code)48000000	8019E450DE000000	8000818014325034	3C073FE3142D73D8	3C05C255142D73DC	3C0643BA142D6C64	3C0F0555142D7E2C	3C0A0555142D7B84
0809F999142D7B88	00000000142D7BE0	2419000C142D7BEC	24080009142D7D84	254B000C142D7E88	0809F9A7142D7E8C	27BDFF98142D80CC	3C0D0555142D8284	0809F9A1142D8288	914A1370142D8024	25AE0006142D8524	254B0006142D85DC	25AC0005142D85CC	3C0A0555142E2E3C	3C180555142E2D98	248C000C142E2FF4
248A0008142E3098	3C0E0555142E3BAC	256B1B60142E3AA0	27181B60142D6DB0	25AD1B60142D6B58	000E78C0142D6B5C	01EE7821142D6B60	00000000142D6BBC	25F8000C142D6C64	3C0F0555142DB3C4	3C05C400142DB3D4	3C054126142DB708	24190157142E3768	24040022142E3784	2404002E142E37CC	240400B4142E37E8
240400BE142E3890	240400FE142E387C	2401000C142E385C	2408000C142E38B8	248400FE1427D5D0	10000044142E389C	83A4001F142E38A0	3C068034142E38A4	3C078034142E38A8	10000003142E38F8	10000012142E3A20	240400C0142E3A34	240400EE142E3A4C	24040100142E3AAC	240400F7142E3C10	2484000C142E3C30
2484000C142E3C50	2484000C1627E664	0000005827BDFFB0	2402000300450019	0000101200022883	24A50027080B5EE3	AFBF0014240B0003	014B001900005012	000A5083080B60A3	01EA5821240E0003	01C4001900007012	000E208324840027	080B5FA4AFBF001C	AFAB0054E0000000	80008000	$	Widescreen	Aspect	Ratio	Fix	for	21:9
(Gecko	Code)48000000	8019E450DE000000	8000818014325034	3C074015142D73D8	3C05C2F8142D73DC	3C0643DE142D6C64	3C0F071C142D7E2C	3C0A071C142D7B84	0809F999142D7B88	00000000142D7BE0	24190009142D7BEC	24080007142D7D84	254B0009142D7E88	0809F9A7142D7E8C	27BDFF98142D80CC	3C0D071C142D8284
0809F9A1142D8288	914A1370142D8024	25AE0005142D8524	254B0005142D85DC	25AC0005142D85CC	3C0A071C142E2E3C	3C18071C142E2D98	248C0009142E2FF4	248A0005142E3098	3C0E071C142E3BAC	256B1B60142E3AA0	27181B60142D6DB0	25AD1B60142D6B58	000E78C0142D6B5C	01EE7823142D6B60	00000000142D6BBC
25F80009142D6C64	3C0F071C142DB3C4	3C05C400142DB3D4	3C054126142DB708	2419019E142E3768	2404001F142E3784	24040028142E37CC	240400B1142E37E8	240400BA142E3890	240400FB142E387C	24010009142E385C	24080009142E38B8	248400FB1427D5D0	10000044142E389C	83A4001F142E38A0	3C068034142E38A4
3C078034142E38A8	10000003142E38F8	10000012142E3A20	240400DC142E3A34	240400FD142E3A4C	24040108142E3AAC	24040103142E3AC0	24040115142E3C10	24840009142E3C30	24840009142E3C50	248400091627E664	0000005827BDFFB0	2402000900450019	0000101200022903	24A50047080B5EE3	AFBF0014240B0009
014B001900005012	000A5103080B60A3	01EA5821240E0009	01C4001900007012	000E210324840047	080B5FA4AFBF001C	AFAB0054E0000000	80008000	$	Widescreen	Aspect	Ratio	Fix	for	48:9	(Gecko	Code)48000000	8019E450DE000000	800081801427D5D0	10000044142CFCAC	252A00C8142CFC88	27180078142CFC8C	44982000142DB3C4
3C05C400142DB3D4	3C054126E0000000	80008000C2052268	000000033F203B6A	9329052C3F20BF12	932905302C190000	00000000C204EAF0	0000000638610048	3C003F1290020000	C2220000C0030000	EC110032D0030000	C003000CEC110032	D003000C60000000	00000000Graphical	and	Interface	Quality	$	Optimized	HUD	for	16:9	(Gecko
Code)48000000	8019E450DE000000	80008180142D6AE8	2B010400142D6AF4	241903FF142E3B58	240E013F142E386C	24040127142E3890	24040137142E38B8	24840137142DB708	24190157142E37B8	240400DD142E37CC	240400ED142E37EA	240400FB142E3754	24040127142E375C	240500C1142E3768	24040137142E3770
240500C1142E3784	24040147142E378C	240500C1142E3A20	240400DD142E3A28	240500A9142E3A34	2404011A142E3A38	240500A9142E3A4C	2404012E142E3A50	240500A9142E3A64	24040150142E3A68	240500A9142E3AAC	24040124142E3AB0	24050030142E3AC0	24040147142E3AC4	24050030E0000000	80008000*	Moves	many	HUD
icons	towards	the	right	of	the	screen.*	May	not	work	properly	with	specific	widescreen	codes.	Some	widescreen	codes	already	align	the	HUD	icons	properly	to	the	borders	of	the	screen.	Do	not	use	this	code	then	if	so.	$	Left-Aligned	Textboxes	for	16:9	(Gecko	Code)48000000	8019E450DE000000	80008180142D8E70	24070000142D8E48
240FFFE9142D8E4C	A5CF0006142DA694	24840184E0000000	80008000*	Moves	All	textboxes	to	X-Position	-23.	Only	affects	textboxes	with	black	or	white	backgrounds.	$	Remove	Dark	Filter	(AR	Code)0404AC50	4E800020*	Makes	the	game	brighter,	the	same	as	on	Project64.	$Remove	Vertical	Black	Lines	(AR	Code)010B1527	000000BC010B1533
00000000010B160E	00000000010B1AE6	00000000010B1B16	00000000010E5676	00000000010E55EA	00000000010E562A	00000000010E5702	00000000010E6B1F	000000BC010E6B2b	00000000*	Remove	the	black	bars	on	the	top	and	bottom	of	the	screen,	allowing	for	a	full	display	and	additional	view.	$Force	Hires	Mario	Model	(AR
Code)030E1304	00001000	$	Extended	Draw	Distance	(AR	Code)0510E71C	000000000514F52C	0000000005174078	000000000517410C	10000006051EDBF0	00000000051EDCB8	00000000051EDCD0	00000000051F0078	1000000D*	Does	not	work	for	grouped/lined	coins	or	some	enemies	(yet).	Objects	should	be	visible	throughout	the	whole	stage.*
This	code	may	and	will	cause	some	graphical	glitches	with	textboxes	and	the	pause	menu	in	specific	stages	when	using	a	widescreen	code.	If	you	can	ignore	that,	feel	free	to	use	it.	$	Hide	HUD	Display	(AR	Code)030B5316	00000000031A53EA	000000000B1A5120	00000100031A53EA	0000000F0B1A5120	00000400031A53EA	000000F0*	Hold	D-Pad
Right	to	show	the	HUD	or	D-Pad	Down	to	show	the	timer.	$	Zoom	Out	Camera	(AR	Code)051A6724	42670000*	Zoom	out	the	camera	to	equal	the	width	of	a	21:9	Aspect	Ratio.	It	must	be	used	with	a	widescreen	code	for	16:9.Extra	Difficulty	$	Double	Damage	Taken	(AR	Code)050BE384	25B9FF80	$	Triple	Damage	Taken	(AR	Code)050BE384
25B9FF40	$	Super	Hard	Mode	(Gecko	Code)48000000	8019E450DE000000	80008180142541D4	272F000014254204	25B9F80014254178	2719FFFD142541A8	241000031425501C	A16000AD142701D4	1000000314270258	100000111424F374	100000041425AAE8	000000001424D94C	100000021424EB14	00000000142B53A0	00000000142689BC
241900001424D9C8	000000001426EC90	0000000014252FDC	1000000814264360	1000000A14276A00	292A0032142769CC	29CF001F14254428	00000000142A72D8	2409000F142C5E30	240D000F1426CEE4	00000000142F3C9C	25F8000014260D4C	100000081425427C	10000006143305F4	040405001424F028	00000000142F8EC8
10000006143050B4	2404004B143050BC	24050014E0000000	80008000*	One	hit	kills	you	and	you	get	a	game	over	if	you	lose	a	life	along	with	a	variety	of	other	stuff	to	make	the	game	harder.	$All	Bosses	Have	1	HP091B83EF	00000003011B83EF	00000001091AF30F	00000003011AF30F	00000001091A7C4F	00000004011A7C4F
00000002091AA96F	00000004011AA96F	00000002091A778F	00000003011A778F	00000001	$All	Bosses	Have	2x	HP091B83EF	00000003011B83EF	00000008091B83EF	00000004011B83EF	00000002091AF30F	00000003011AF30F	00000008091AF30F	00000004011AF30F	00000002091A7C4F	00000004011A7C4F	00000009091A7C4F
00000005011A7C4F	00000003091AA96F	00000004011AA96F	00000009091AA96F	00000005011AA96F	00000003091A810F	00000001011A810F	00000003091A810F	00000002011A810F	00000000911A778F	000000004A002FC2	00000000811A778F	0000000102002FC2	0000000100000000	40000000491A778F	000000000A002FC2
0000000102002FC2	00000000	$All	Bosses	Have	3x	HP091B83EF	00000003011B83EF	0000000B091B83EF	00000004011B83EF	00000002091AF30F	00000003011AF30F	0000000B091AF30F	00000004011AF30F	00000002091A7C4F	00000004011A7C4F	0000000C091A7C4F	00000005011A7C4F	00000003091AA96F	00000004011AA96F
0000000C091AA96F	00000005011AA96F	00000003091A810F	00000001011A810F	00000004091A810F	00000002011A810F	00000000911A778F	000000004A002FC2	00000000811A778F	0000000202002FC2	0000000100000000	40000000491A778F	000000000A002FC2	0000000102002FC2	00000000For	Fun	$Infinite	Health	(AR	Code)011A539E
00000008	$	Fix	Backwards	Long	Jump	Glitch	(Gecko	Code)48000000	8019E450DE000000	80008180142528DC	10000005142528E0	AD400110142528E4	240C0001142528E8	8D6F0088142528EC	ADEC0110142528F0	3C013FC0142528F4	44818000142528F8	C56A0054142528FC	3C01424014252900	4481300014252904	4610548214252908
E57200541425290C	4612303C14252910	0000000014252914	4500000214252918	000000001425291C	E566005414252920	3C01C17014252924	4481300014252928	4606903C1425292C	0000000014252930	4500000214252934	0000000014252938	E56600541425293C	08094A6914252940	00000000E0000000	80008000*	It	sets	your	speed	to	-15
when	starting	a	long	jump	if	your	speed	is	below	that	when	you	start	it.	$	Walk	While	Reading	a	Sign	(Gecko	Code)48000000	8019E450DE000000	800081801428BD34	03E000081428BD38	00000000142A4708	240E0000E0000000	80008000	$	Activate	Cap	Anywhere	(AR	Code)0B1A5120	00000110031A52F6	0000001D0B1A5120	00000210031A52F6
000000170B1A5120	00000410031A52F6	0000001B0B1A5120	00000810031A52F6	0000001F0B1A5120	00002100031A52F6	000000190B1A5120	00002200031A52F6	000000150B1A5120	00002400031A52F6	000000130B1A5120	00002800031A52F6	00000011*	Press	these	buttons	combination	to	instantly	activate	caps:*	Z	+	D-Pad	Right	=	Wing
Cap,	Z	+	D-Pad	Left	=	Metal	Cap,	Z	+	D-Pad	Down	=	Vanish	Cap	or	Z	+	D-Pad	Up	=	Normal	Cap.*	R	+	D-Pad	Right	=	Wing	+	Metal	Cap,	R	+	D-Pad	Left	=	Vanish	+	Metal	Cap,	R	+	D-Pad	Down	=	Wing	+	Vanish	Cap	or	R	+	D-Pad	Up	=	Wing	+	Vanish	+	Metal	Cap.	$	Completed	Save	Files	(Gecko	Code)05071888	1F10FFCF050718F8
1F10FFCF05071968	1F10FFCF050719D8	1F10FFCF0507188C	FFFFFFFF05071890	FFFFFFFF05071894	FFFFFFFF05071898	FFFFFF810507189C	01010301050718A0	01010181050718A4	00928D68050718A8	9A978B85050718AC	886A7F98050718B0	89BF8092050718FC	FFFFFFFF05071900	FFFFFFFF05071904	FFFFFFFF05071908
FFFFFF810507190C	0101030105071910	0101018105071914	00928D6805071918	9A978B850507191C	886A7F9805071920	89BF80920507196C	FFFFFFFF05071970	FFFFFFFF05071974	FFFFFFFF05071978	FFFFFF810507197C	0101030105071980	0101018105071984	00928D6805071988	9A978B850507198C	886A7F9805071990
89BF8092050719DC	FFFFFFFF050719E0	FFFFFFFF050719E4	FFFFFFFF050719E8	FFFFFF81050719EC	01010301050719F0	01010181050719F4	00928D68050719F8	9A978B85050719FC	886A7F9805071A00	89BF8092*	All	four	save	files	have	120	stars	with	everything	unlocked	and	the	maximum	amount	of	coins	for	each	stage.	Activate	the	code,
get	a	star	and	save	the	game.	Then	disable	the	code	to	have	that	save	file	permanently	completed.	$	Moon	Jump	(Gecko	Code)48000000	8019E450DE000000	800081803833AFA0	7FFF80001433B1BC	42200000E0000000	80008000*	Hold	A.	Can	Also	Hold	Any	Other	Button.	$	Disable	Death	Barrier	(Gecko	Code)48000000	8019E450DE000000
80008180142505F4	10000013E0000000	80008000	$	Walk	Through	Walls	(Gecko	Code)48000000	8019E450DE000000	8000818014380EE0	1000000414255C3C	10000003143813FC	0000000014381B98	0809000C14240030	8FBB000C14240034	8F7B000014240038	141B00081424003C	0000000014240040	8FBB000C14240044	3C05802314240048
2404000A1424004C	A4A4000014240050	AF65000014240054	3C1BC5FF14240058	449B00001424005C	03E0000814240060	00000000E0000000	80008000*	Works	for	all	levels.Demonstration	Screenshots	Super	Mario	64	(PAL):Widescreen	$	Widescreen	Aspect	Ratio	Fix	for	16:9	(Gecko	Code)48000000	8019EE50DE000000	800081801426D458
3C0147F0142A7C2C	3C028033142A7C30	2442F560142A7C34	8C430004142A7C38	8C450008142A7C3C	24790028142A7C40	44992000142A7C48	00000000142A7C4C	24790118142B1190	3C05C400142B11A4	3C054126E0000000	80008000C2052298	000000033F203B99	9329052C3F20BF40	932905302C190000	00000000C204EB20
0000000638610048	3C003F4090020000	C2220000C0030000	EC110032D0030000	C003000CEC110032	D003000C60000000	00000000	$	Widescreen	Aspect	Ratio	Fix	for	21:9	(Gecko	Code)48000000	8019EE50DE000000	800081801426D458	3C0147F0142A7C2C	3C028033142A7C30	2442F560142A7C34	8C430004142A7C38	8C450008142A7C3C
24790045142A7C40	44992000142A7C48	00000000142A7C4C	247900FB142B1190	3C05C400142B11A4	3C054126E0000000	80008000C2052298	000000033F203B6A	9329052C3F20BF12	932905302C190000	00000000C204EB20	0000000638610048	3C003F1290020000	C2220000C0030000	EC110032D0030000	C003000CEC110032
D003000C60000000	00000000	$	Widescreen	Aspect	Ratio	Fix	for	48:9	(Gecko	Code)48000000	8019EE50DE000000	800081801426D458	3C0147F0142A7C2C	3C028033142A7C30	2442F560142A7C34	8C430004142A7C38	8C450008142A7C3C	24790078142A7C40	44992000142A7C48	00000000142A7C4C	247900C8142B1190	3C05C400142B11A4
3C054126E0000000	80008000C2052298	000000033F203ACC	9329052C3F20BE80	932905302C190000	00000000C204EB20	0000000638610048	3C003E8090020000	C2220000C0030000	EC110032D0030000	C003000CEC110032	D003000C60000000	00000000Graphical	and	Interface	Quality	$	Remove	Dark	Filter	(AR	Code)0404AC60	4E800020*
Makes	the	game	brighter,	the	same	as	on	Project64.	$	Zoom	Out	Camera	(AR	Code)	-	DO	NOT	USE	THIS	CODE!	IS	BROKEN!051754C4	42670000*	Zoom	out	the	camera	to	equal	the	width	of	a	21:9	Aspect	Ratio.	It	must	be	used	with	a	widescreen	code	for	16:9.	Super	Mario	64	(NTSC-J):Widescreen	$	Widescreen	Aspect	Ratio	Fix	for	16:9	(Gecko
Code)C2052268	000000033F203B99	9329052C3F20BF40	932905302C190000	00000000C204EAF0	0000000638610048	3C003F4090020000	C2220000C0030000	EC110032D0030000	C003000CEC110032	D003000C60000000	00000000050DF994	3C01476005120E94	3C02803405120E98	24423B0005120E9C	8C43000405120EA0
8C45000805120EA4	2479002805120EA8	4499200005120EAC	0000000005120EB0	0000000005120EB8	0000000005120EBC	247901180512932C	3C05C26005129340	3C05405D	$	Widescreen	Aspect	Ratio	Fix	for	21:9	(Gecko	Code)C2052268	000000033F203B6A	9329052C3F20BF12	932905302C190000	00000000C204EAF0	0000000638610048
3C003F1290020000	C2220000C0030000	EC110032D0030000	C003000CEC110032	D003000C60000000	00000000050DF994	3C0147A005120E94	3C02803405120E98	24423B0005120E9C	8C43000405120EA0	8C45000805120EA4	2479004505120EA8	4499200005120EAC	0000000005120EB0	0000000005120EB8	0000000005120EBC
247900FB0512932C	3C05C2F405129340	3C054092	$	Widescreen	Aspect	Ratio	Fix	for	48:9	(Gecko	Code)C2052268	000000033F203ACC	9329052C3F20BE80	932905302C190000	00000000C204EAF0	0000000638610048	3C003E8090020000	C2220000C0030000	EC110032D0030000	C003000CEC110032	D003000C60000000	00000000050DF994
3C0147E005120E94	3C02803405120E98	24423B0005120E9C	8C43000405120EA0	8C45000805120EA4	2479007805120EA8	4499200005120EAC	0000000005120EB0	0000000005120EB8	0000000005120EBC	247900C80512932C	3C05C40005129340	3C054126Graphical	and	Interface	Quality	$	Remove	Dark	Filter	(AR	Code)0404AC50	4E800020*
Makes	the	game	brighter,	the	same	as	on	Project64.	$	Zoom	Out	Camera	(Gecko	Code)	-	DO	NOT	USE	THIS	CODE!	BROKEN!050F7124	3C1B4267050F7130	AC9B001C2100D27C	C426483C0500D2C0	3C064267E2000001	80008000*	Zoom	out	the	camera	to	equal	the	width	of	a	21:9	Aspect	Ratio.	It	must	be	used	with	a	widescreen	code	for
16:9.Extra	Difficulty	$	Double	Damage	Taken	(AR	Code)050BF328	2458FF80	$	Triple	Damage	Taken	(AR	Code)050BF328	2458FF40	$	Super	Hard	Mode	(Gecko	Code)48000000	8019E310DE000000	8000818014255338	A48000AE14255E50	A16000AD142552C8	244BFFFD142552F8	24030003142D2538	0000000014296634	2409000F1430FD24
04040500142AFE58	2418000F142E04C8	24040032142E04E0	240500141426C870	00000000142502EC	000000001425A474	0000000014255314	A48000AE142502DC	00000000E0000000	80008000*	One	hit	kills	both	players	and	you	get	a	game	over	if	you	lose	a	life	along	with	a	variety	of	other	stuff	to	make	the	game	harder.For	Fun	$	Completed
Save	Files	(Gecko	Code)48000000	8019E310DE000000	8000818014203F08	1F10FFCF14203F78	1F10FFCF14203FE8	1F10FFCF14204058	1F10FFCF14203F0C	FFFFFFFF14203F10	FFFFFFFF14203F14	FFFFFFFF14203F18	FFFFFF8114203F1C	0101030114203F20	0101018114203F24	00928D6814203F28	9A978B8514203F2C
886A7F9814203F30	89BF809214203F7C	FFFFFFFF14203F80	FFFFFFFF14203F84	FFFFFFFF14203F88	FFFFFF8114203F8C	0101030114203F90	0101018114203F94	00928D6814203F98	9A978B8514203F9C	886A7F9814203FA0	89BF809214203FEC	FFFFFFFF14203FF0	FFFFFFFF14203FF4	FFFFFFFF14203FF8	FFFFFF8114203FFC
0101030114204000	0101018114204004	00928D6814204008	9A978B851420400C	886A7F9814204010	89BF80921420405C	FFFFFFFF14204060	FFFFFFFF14204064	FFFFFFFF14204068	FFFFFF811420406C	0101030114204070	0101018114204074	00928D6814204078	9A978B851420407C	886A7F9814204080	89BF8092E0000000	80008000*	All
four	save	files	have	120	stars	with	everything	unlocked	and	the	maximum	amount	of	coins	for	each	stage.	Activate	the	code,	get	a	star	and	save	the	game.	Then	disable	the	code	to	have	that	save	file	permanently	completed.	Super	Mario	64	Multiplayer	(V1.3):Widescreen	$	Widescreen	Aspect	Ratio	Fix	for	16:9	(Gecko	Code)C20AF1F0
00000005C0230000	4182001C92C20000	3EC03F4092C30000	C023000092C30008	82C2000060000000	00000000C2054960	0000000592A20000	3EA03B9962B5999A	92A9052C3EA0BF40	92A9053082A20000	2C03000060000000	00000000C204F304	000000042C040001	4082001492A20000	3EA03F4092A10008	82A2000038610008
0000000005409CD4	3C05405D05409CC4	3C05C260053ABE5C	3C014740053FE620	3C08BE80	$	Widescreen	Aspect	Ratio	Fix	for	21:9	(Gecko	Code)C20AF1F0	00000005C0230000	4182001C92C20000	3EC03F1292C30000	C023000092C30008	82C2000060000000	00000000C2054960	0000000592A20000	3EA03B6A62B50EAC	92A9052C3EA0BF12
92A9053082A20000	2C03000060000000	00000000C204F304	000000042C040001	4082001492A20000	3EA03F1292A10008	82A2000038610008	0000000005409CD4	3C05409205409CC4	3C05C2F4053ABE5C	3C014780053FE620	3C08BED0	$	Widescreen	Aspect	Ratio	Fix	for	48:9	(Gecko	Code)C20AF1F0	00000005C0230000	4182001C92C20000
3EC03E8092C30000	C023000092C30008	82C2000060000000	00000000C2054960	0000000592A20000	3EA03ACC62B5CCCD	92A9052C3EA0BE80	92A9053082A20000	2C03000060000000	00000000C204F304	000000042C040001	4082001492A20000	3EA03E8092A10008	82A2000038610008	0000000005409CD4	3C05412605409CC4
3C05C400053ABE5C	3C0147C0053FE620	3C08BF40Graphical	and	Interface	Quality	$	Remove	Dark	Filter	(AR	Code)04057C04	60000000*	Makes	the	game	brighter,	the	same	as	on	Project64.Extra	Difficulty	$	Double	Damage	Taken	(AR	Code)05382B04	25B9FF80	$	Triple	Damage	Taken	(AR	Code)05382B04	25B9FF40	$	Super	Hard	Mode	(Gecko
Code)48000000	801B6378DE000000	80008180142541D4	272F000014254204	25B9F80014254178	2719FFFD142541A8	241000031425501C	A16000AD142701D4	1000000314270258	100000111424F374	100000041425AAE8	000000001424D94C	100000021424EB14	00000000142B53A0	00000000142689BC	241900001424D9C8	000000001426EC90
0000000014252FDC	1000000814264360	1000000A14276A00	292A0032142769CC	29CF001F14254428	00000000142A72D8	2409000F142C5E30	240D000F1426CEE4	00000000142F3C9C	25F8000014260D4C	100000081425427C	10000006143305F4	040405001424F028	00000000142F8EC8	10000006143050B4	2404004B143050BC
24050014142764CC	10000015142AC4CC	100000211425B614	1000000CE0000000	80008000*	One	hit	kills	both	players	and	you	get	a	game	over	if	you	lose	a	life	along	with	a	variety	of	other	stuff	to	make	the	game	harder.For	Fun	$	Fix	Backwards	Long	Jump	Glitch	(Gecko	Code)48000000	801B6378DE000000	80008180142528DC
10000005142528E0	AD400110142528E4	240C0001142528E8	8D6F0088142528EC	ADEC0110142528F0	3C013FC0142528F4	44818000142528F8	C56A0054142528FC	3C01424014252900	4481300014252904	4610548214252908	E57200541425290C	4612303C14252910	0000000014252914	4500000214252918	000000001425291C
E566005414252920	3C01C17014252924	4481300014252928	4606903C1425292C	0000000014252930	4500000214252934	0000000014252938	E56600541425293C	08094A6914252940	00000000E0000000	80008000*	It	sets	your	speed	to	-15	when	starting	a	long	jump	if	your	speed	is	below	that	when	you	start	it.	$	Walk	While	Reading	a	Sign
(Gecko	Code)48000000	801B6378DE000000	800081801428BD34	03E000081428BD38	00000000142A4708	240E0000E0000000	80008000	$	Moon	Jump	for	Player	1	(Gecko	Code)48000000	801B6378DE000000	800081803833AFA0	7FFF80001433B1BC	42200000E0000000	80008000*	Hold	A.	Can	Also	Hold	Any	Other	Button.	$	Moon	Jump	for	Player
2	(Gecko	Code)48000000	801B6378DE000000	800081803833AFBC	7FFF8000143FF14C	42200000E0000000	80008000*	Hold	A.	Can	Also	Hold	Any	Other	Button.	$	Disable	Death	Barrier	(Gecko	Code)48000000	801B6378DE000000	80008180142505F4	10000013E0000000	80008000	$	Partial	Walk	Through	Walls	(Gecko	Code)48000000
801B6378DE000000	8000818014380EE0	1000000414255C3C	10000003143813FC	00000000E0000000	80008000*	Only	Works	if	Floor	is	Below	You	or	in	Levels	with	the	Death	Barrier.	Disables	Ceiling	Collision.	Camera	Can	Also	Go	Through	Walls.IMPORTANT*	Each	spoiler	is	tagged	with	the	game	version.	Carefully	check	if	codes	ar	AR	or	Gecko.*
Disable	the	"Widescreen	Hack"	(Graphics	->	Enhancements).	If	using	the	PAL	version	then	enable	the	"Widescreen	Hack".*	Select	"Stretch	to	Window"	(Graphics	->	General	-	Display	-	Aspect	Ration).*	Only	use	one	Widescreen	code	at	a	time.*	Either	use	Double	or	Triple	Damage	Taken.	Do	not	use	them	both.*	Only	codes	that	improve	the	quality	of
the	game	are	requested	such	as	improving	upon	difficulty	(extra	damage),	fun	(instant	caps)	or	visual	experience	(60	FPS,	widescreen,	extended	view).*	Know	any	good	codes?	Great,	let	me	know	and	I	add	them	into	the	code	section	here.	Changes:	Credits:	---	Sources	---Fanfreluche's	Fan	FontHypatia's	Hi-Res	Wind	Waker	(Termina
Invasion)Mollymutt's	Super	Mario	64MU-TH-UR's	Super	Mario	64Nerrel's	MM	N64HD	(Termina	Invasion)p3st's	Texture	PackPoke	Headroom's	Render96	HD	Texture	PackSM64	RedrawnSuper	Mario	64	-	Plumbers	Unite	Edition	(by	Roovahlees	&	Teaufou)	Icon:	Bomb	(Termina	Invasion)Icon:	Clock	(Italian	translation)Icon:	Dog	FaceIcon:	Link	Head
(Termina	Invasion)Icon:	Majora's	Mask	Clock	(Termina	Invasion)Icon:	Ocarina	(Termina	Invasion)Icon:	Toon	Link	Head	(Termina	Invasion)Icon:	Triforce	(Termina	Invasion)Painting:	Jolly	Roger	Bay	AdmentusJames:	Rupee	object	(Termina	Invasion)michaeltung:	Grindel	textureRulesless:	Italien	texturesWARIO:	iQue	textures	Social:	Join	my	Discord
Channel	for	discussion	and	support:	Please	consider	supporting	me	on	Patreon	or	PayPal	if	you	like	my	projects:	//www.paypal.com/paypalme/Admentus/	Moved	to	the	HD	Texture	forum.	Looks	really	nice!	Keep	up	the	good	work.	I	was	also	doing	a	Mollymutt	pack	port	months	ago	but	stopped.	I'll	tell	you	what	I	have	when	I	arrive	home.	CPU:	Intel
Core	i5	4670k	@	4.4GHzGPU:	GAINWARD	GeForce	GTX	1080	Phoenix	"GLH"RAM:	G.SKILL	Ripjaws	X	DDR3	16GB	1600MHz	CL7OS:	Windows	7	Ultimate	x64	03-23-2016,	03:31	AM	(This	post	was	last	modified:	05-10-2016,	04:46	PM	by	Lumbeeslayer.)#4	Check	this	Super	Mario	64	Texture	Pack	out!	In	my	opinion	its	the	best	Mario	64	Texture	Pack,
and	would	be	perfect	to	port	to	Dolphin.	Its	also	100%	completed.	craft+64	03-23-2016,	03:34	AM	(This	post	was	last	modified:	03-23-2016,	03:40	AM	by	Admentus.)#5	Ahh	yes,	I	did	see	that	before.	Alas,	it	is	for	Project64.Also	I	prefer	higher	resolutions	instead	of	the	painterly	style.Mollymutt's	pack	is	100%	finished,	but	I	use	the	textures	from
Razius	as	their	are	higher	quality	when	available.Most	work	would	be	the	renaming	of	files,	so	if	you	would	like	to	replace	it	with	another	texture	pack.	Feel	free.As	I	stated,	I	do	not	take	credits.	Just	trying	the	contribute	to	the	Dolphin	hires	textures	cause.	(03-23-2016,	03:34	AM)Admentus	Wrote:	Ahh	yes,	I	did	see	that	before.	Alas,	it	is	for
Project64.Also	I	prefer	the	more	high	resolution	style	instead	of	the	painterly	style.Mollymutt's	pack	is	100%	finished,	but	I	use	the	textures	from	Razius	as	their	are	higher	quality	when	available.Well	technically	its	a	paper	craft	style	then	painting	style	but	ok	I	understand	That	paper	craft	style	texture	pack	actually	looks	really	good,	is	there	any	way
to	port	that	over	to	Dolphin?	Great	job!	Are	you	planning	on	doing	it	for	other	games?	Like	Smash	Bros	64	for	example?	Here	is	what	I	had	done:	You'll	find	textures	with	the	N64	names	too,	and	an	optional	widescreen	HUD	(in	a	7z	file.	Also	the	4:3	version	in	case	I	wanted	to	switch	between	them).I	hope	it	serves	you	well.	CPU:	Intel	Core	i5	4670k	@
4.4GHzGPU:	GAINWARD	GeForce	GTX	1080	Phoenix	"GLH"RAM:	G.SKILL	Ripjaws	X	DDR3	16GB	1600MHz	CL7OS:	Windows	7	Ultimate	x64	Thank	you	very	much,	Masterotaku.Makes	the	work	easier.I	don't	know	if	I	have	time	for	it	tomorrow,	busy	day.But	I	should	be	able	to	search	through	it	before	the	end	of	the	week.	
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